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LAMPIRAN 
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Lampiran 1 : Terjemah Ayat Al-Qur’an 

No Bab Kutipan Terjemah 

1 1 Q .S Al- Alaq 

Ayat 1-5 

1) Bacalah dengan (menyebut) nama 

Tuhanmu yang menciptakan,  

2) Dia telah menciptakan manusia dari 

segumpal darah 

3) Bacalah, dan Tuhanmulah yang maha 

Mulia 

4) Yang mangajar (manusia) dengan pena 

5) Dia mangajarkan manusia apa yang tidak 

diketahuinya. 
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Lampiran 2: Surat Penetapan Dosen Pembimbing Skripsi 
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Lampiran 3: Surat Penetapan Dosen Pembimbing Skripsi Pengganti 
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Lampiran 4 : Bukti Seminar Proposal  
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Lampiran 5 : Surat Permohonan Menjadi Validator  Media Pembelajaran  
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Lampiran 6 : Surat Persetujuan Penelitian dari Dosen Pembimbing 
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Lampiran 7 : Surat Izin Penelitian dari MIKWA FTK UIN Antasari 

Banjarmasin 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



81 

 

 
 
 

 

 

 

 



82 

 

 
 
 

Lampiran 8 : Surat Selesai Penelitian 
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Lampiraan 9 : Lembar Hasil Validasi Ahli Media 

1. Lembar Validator I  (Alvian Ikhsanul Fatya, S. Pd., M. Si) 
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2. Lembar Validator II ( Helda Rahmawati, S.Si., M.Pd) 
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3. Lembar Validator III ( Laila Sopia, S. Pd) 
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Lampiran 10 : Lembar Hasil Validasi Modul Ajar 

 

1. Lembar Validator I  (Alvian Ikhsanul Fatya, S. Pd., M. Si) 
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2. Lembar Validator II ( Helda Rahmawati, S.Si., M.Pd) 
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3. Lembar Validator III ( Laila Sopia, S. Pd) 
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Lampiran 11 : Lembar Hasil  Validasi  Soal oleh Tim Ahli 

 

  INSTRUMEN PENELITIAN      

KISI SOAL PRETEST DAN POSTTEST 

 

Nama Sekolah  :  SMA Negeri 1 Gambut   Penyusun   : Aulia Rahmi 

Mata Pelajaran : Kimia               Tahun Pelajaran : 2022/2023 

Bahan Kelas/SMT : X/II 

Bentuk Soal Tes  : Pilihan Ganda 

Kompetensi Dasar  : Menganalisis sifat larutan elektrolit dan non-elektrolit 

berdasarkan daya hantar listriknya  

Materi                         : Larutan elektrolit dan non-elektrolit 

No 
Indikator 

Soal 
Butiran Soal Jenjang  

Kunci 

Jawaban 

1 Mengidentifika

si gejala yang 

muncul pada 

hantaran arus 

listik 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Seorang siswa sedang mengidentfikasi 

gejala yang menyebabkan larutan 

elektrolit dapat menghantarkan arus listrik 

melalui beberapa pernyataan berikut : 

1) Muncul gelembung disekitar elektroda  

2) Larutan dapat terurai menjadi ion 

positif dan negatif 

3) Larutan berasal dari senyawa ion 

4) Larutan berasal dari senyawa kovalen 

nonpolar 

5) Larutan merupakan lelehan senyawa 

kovalen 

 

Berdasarkan prnyataan di atas  yang benar 

mengenai larutan elektrolit adalah …. 

(A) 1, 2 dan 5 

(B) 2,3 dan 5 

(C) 1, 2,dan 3 

(D) 2, 3, dan 4 

(E) 1, 2, dan 4 

C3 C 
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2 Menganalisis 

larutan 

elektrolit yang 

sesuai dengan 

pernyataan  

Lia ingin menguji larutan eksperimen 

yang menunjukkan daya hantar listriknya. 

Sedangkan melalui pembuktian dengan 

adanya gelembung di elektroda, tetapi 

lampu pada  alat penguji elektrolit redup. 

Berdasarkan dari larutan di bawah ini, 

larutan yang digunakan oleh Lia 

adalah…… 

(A) Larutan gula  (C6H12O6) 

(B) Larutan asam asetat (CH3COOH)  

(C) Larutan urea (CO(NH2)2) 

(D) Larutan natrium hidroksida 

(NaOH) 

(E) Air murni  

C3 B 

3 Menyimpulkan 

ciri-ciri 

hantaran pada 

arus listrik 

dalam berbagai 

larutan  

Peristiwa terurainya molekul senyawa ion 

menjadi ion-ion disebut sebagai….. 

(A) Ioninasi  

(B) Senyawa ion 

(C) Seyawa kovalen 

(D) Larutan 

(E) Zat elektrolit 

C2 A 

4 Mengidentifika

si hasil 

percobaan ke 

dalam 

pengetian 

elektrolit  

Dalam sebuah beker terdapat larutan yang 

memiliki daya hantar listrik yang baik dan 

menimbulkan gelembung ketika di uji dan 

disimpulkan bahwa larutan tersebut 

merupakan larutan elektrolit.  Pernyataan  

di bawah ini yang sesuai dengan ciri ciri 

larutan di atas adalah….  

(A) Zat terlarut adalah zat 

nonelektrolit 

(B) Ion-ion dalam larutan bergerak 

menuju elektroda  

(C) Jumlah ion dalam larutan sedikit 

(D) Derajat ionisasinya > 1 

C3 B 
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(E) Tidak ada ion dalam larutan yang 

bergerak menuju elektroda 

5 Menentukan 

ciri-ciri zat 

non-elektrolit  

Dibawah ini, ciri-ciri zat yang dalam fase 

liquid tidak dapat menghantarkan listrik 

adalah…. 

(A) NaCl 

(B) CaCl12 

(C) KI 

(D) Al2(SO4)3 

(E) C12H22O11 

C3 E 

6 Menentukkan 

larutan 

berdasarkan 

daya hantar 

listrik 

Gula pasir (sukrosa) di dalam air tetap 

sebagai molekul sukrosa (C12H22O11). 

Peristiwa ini menunjukkan bahwa sukrosa 

bersifat….. 

(A) Elektrolit kuat 

(B) Dapat menyalakan lampu 

(C) Dapat menghantarkan listrik 

(D) Elektrolit lemah 

(E) Nonelektrolit 

C3 E 

7 Menganalisis 

sifat larutan 

elektrolit dan 

non-elektrolit 

berdasarkan 

daya hantar 

listrik sesuai 

dengan data 

hasil percobaan 

Daya hantar listrik yang besar sehingga 

menyebabkan nyala lampu terang 

merupakan larutan elektrolit yang 

bersifat….. 

(A) Sedang 

(B) Lemah 

(C) Sangat rendah 

(D) Tinggi 

(E) Kuat  

C2 E 
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8  Menganalisis 

sifat larutan 

elektrolit dan 

non-elektrolit 

berdasarkan 

daya hantar 

listrik 

Garam dapur dan cuka keduanya dapat 

menghantarkan arus listrik, hal ini 

menunjukkan bahan kedua larutan itu …. 

(A) Bersifat basa 

(B) Bersifat asam 

(C) Dapat saling bereaksi 

(D) Bersifat netral 

(E) Mengalami ionisasi 

C3 E 

9 Menganalisis 

sifat larutan 

elektrolit dan 

non-elektrolit 

berdasarkan 

daya hantar 

listrik 

Zat dibawah ini yang termasuk larutan 

elektrolit senyawa kovalen dan bersifat 

basa adalah………… 

(A) CH3COOH 

(B) NH3 

(C) HCl 

(D) C12H22O11 

(E) PO(OH)3 

C3 B 

10 Menganalisis 

penyebab 

hantaran arus 

listrik pada 

larutan 

elektrolit 

Suatu larutan dapat menghantarkan listrik 

apabila mengandung….. 

(A) Ion-ion yang bergerak bebas 

(B) Elektron yang bergerak bebas 

(C) senyawa kovalen nonpolar 

(D) Air yang dapat menghantarkan 

listrik 

(E) Air yang terionisasi  

C3 A 

11 Menganalisis 

penyebab 

hantaran arus 

listrik pada 

larutan 

elektrolit 

berdasarkan 

hasil percobaan 

Lampu alat penguji elektrolit tidak 

menyala ketika elektrodanya dicelupkan   

ke dalam larutan asam cuka, tetapi pada 

elektroda tetap terbentuk gelembung gas, 

penjelasan untuk keadaan ini adalah…. 

(A) Cuka bukan elektrolit 

(B) Gas yang terbentuk di katode 

(C) Hanya beberapa molekul cuka 

yang terionisasi 

(D) Cuka merupakan elektrolit kuat 

C3 c 
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(E) Alat penguji elektrolit rusak 

 

 

12 Menganalisis 

penyebab 

hantaran arus 

listrik pada 

larutan 

elektrolit 

Jika arus listrik di alirkan melalui NaCl 

cair dan HCl cair, maka akan 

menyebabkan….. 

(A) HCl mengalirkan aliran listrk 

(B) NaCl dan HCl mengalir aliran 

listrik 

(C) NaCl cair mengalirkan aliran 

listrik 

(D) NaCl dan HCl tidak mengalirkan 

aliran listrik 

(E) NaCl dan HCl mengalirkan aliran 

listrik hanya jika dilarutkan ke 

dalam air 

C3 C 

13 Menentukan 

larutan 

berdasarkan 

ciri-ciri daya 

hantar 

listriknya 

Larutan yang bukan dikategorikan dalam 

larutan elektrolit adalah… 

(A) Tawas 

(B) Cuka 

(C) Minyak tanah 

(D) Soda 

(E) Kaporit  

C2 C 

14 Menentukan 

penyebab 

larutan 

menghantakan 

listrik dengan 

menggunakan 

elektrode 

Sepasang elektrode  yang dihubungkan  

dengan baterai  dan lampu dicelupkan  ke 

dalam  asam sulfat encer . ternyata lampu 

menyala, hal ini disebabkan…. 

(A) Asam sulfat terionisasi karena 

adanya arus listrik 

(B) Asam sulfat tidak terionisasi 

(C) Pelarut asam dalam air  disertai 

dengan pengeluaran elektron  

(D) Asam sulfat dalam keadaan murni 

memang tersusun dari ion  

(E) Asam sulfat mempebesar 

konsentrasi ion H+ sebagai syarat 

penghantar listrik 

C2 E 
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15 Menganalisis 

larutan non-

elektrolit yang 

sesuai dengan 

pernyataan 

Bahan-bahan dibawah ini tergolong dalam 

larutan non-elektrolit, kecuali…. 

(A) Air garam 

(B) Spritus 

(C) Alkohol 

(D) Air gula 

(E) Larutan urea 

C2 D 

16 Mengidentifika

si larutan 

elektrolit 

berdasarkan 

daya hantar 

listriknya 

Seorang peneliti mengambil sampel 

limbah cair dari berbagai tempat. 

Kemudian sampel tersebut di uji 

menggunakan uji daya hantar listrik. 

Berdasarkan hasil penelitian, diperoleh 

hasil berikut ini. 

 

Limbah 
Pengamatan 

gelembung gas 

Nyala 

lampu 

P Ada gelembung Terang 

Q Ada gelembung Mati 

R 
Tidak ada 

gelembung 
Mati 

S Ada gelembung Redup 

 

Berdasarkan tabel penelitian di atas, 

secara berurutan sampel limbah 

mengandung sifat elektrolit….. 

 

 

(A) P (Elektrolit kuat); Q (Elektrolit 

lemah); R (nonelektrolit); S 

(elektrolit lemah) 

(B) P (Elektrolit kuat); Q 

(nonelektrolit); R 

(nonelektrolit); S (elektrolit 

lemah) 

(C) P (Elektrolit kuat); Q (Elektrolit 

lemah); R (elektrolit lemah); S 

(elektrolit lemah) 

C3 A 
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(D) P (Elektrolit kuat); Q (Elektrolit 

lemah); R (elektrolit lemah); S 

(nonelektrolit) 

(E) P (Elektrolit lemah); Q 

(nonelektrolit ); R 

(nonelektrolit); S (elektrolit 

lemah) 

 
 

17 Menentukan  

larutan yang 

dapat  

menghantarkan 

listrik 

Beberapa larutan yang dapat 

menghantarkan arus listrik adalah…. 

(A) Asam, basa, dan garam 

(B) Asam, glukosa, dan anorganik 

(C) Basa, alkohol, dan minyak 

(D) Garam , minyak, dan parfum 

(E) Garam, basa dan minyak 

  

C2 A 

18 Menentukan 

senyawa 

elektrolit dan 

sifat ikatannya  

Jika asam cuka ( CH3COOH) dilarutkan 

ke dalam air, hanya sebagian kecil yang 

terurai menjadi ion-ion, karena asam cuka 

1) Elektrolit kuat 

2) Senyawa kovalen nonpolar 

3) Senyawa ion 

4) Senyawa kovalen polar 

5) Elektrolit  lemah 

Pernyataan di atas yang benar 

adalah…. 

(A) 1dan 2 

(B) 1 dan 3 

(C) 4 dan 5 

(D) 2 dan 3 

(E) 3 dan 4   

 

C2 C 



108 

 

 
 
 

19 Menentukan 

senyawa 

berdasakan 

daya hantar 

listrik yang 

sudah 

diketahui 

Senyawa HCl merupakan contoh dari 

senyawa….. 

(A) Senyawa ionik yang bersifat 

elektrolit 

(B) Senyawa ionik yang bersifat 

nonelektrolit 

(C) Senyawa kovalen yang bersifat  

nonelektrolit 

(D) Senyawa asam lemah yang bersifat 

nonelektrolit 

(E) Senyawa kovalen yang bersifat 

elektrolit 

C3 E 

20 Menganalisis 

larutan 

elektrolit dapat 

berupa 

senyawa ion 

dan senyawa 

kovalen 

Seorang siswa sedang mengidentifikasi 

senyawa X yang memiliki sifat sebagai 

berikut: 

1) Mudah larut dalam air 

2) Dapat menghantarkan listrik dalam 

fase cair  

3) Titik didih dan titik lelehnya tinggi 

4) Tidak larut dalam pelarut nonpolar 

  

Jenis ikatan dalam senyawa X tersebut 

adalah………. 

(A) Kovalen polar 

(B) Kovalen nonpolar 

(C) Hidrogen 

(D) Logam  

(E) Ion  

C3 E 
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1. Lembar  Validator I  (Alvian Ikhsanul Fatya, S. Pd., M. Si) 
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2. Lembar Validator II  ( Helda Rahmawati, S.Si., M.Pd) 
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3. Lembar Validator III ( Laila Sopia, S. Pd) 
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Lampiran 12 : Lembar Hasil Observasi Keterlaksanaan Pembelajaran 
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Lampiran 13 : Lembar Hasil Respon Siswa 

NO 
Kode 

Siswa 
SS K KS TS STS Total 

1 P1 
6 

30% 

2 

8% 

2 

6% 
0 0 

44 

88% 

2 P2 
6 

30% 

4 

16% 
0 0 0 

46 

92% 

3 P3 
2 

10% 

5 

50% 

3 

9% 
0 0 

39 

78% 

4 P4 
4 

20% 

6 

24% 
0 0 0 

44 

88% 

5 P5 
2 

10% 

7 

28% 

1 

3% 
0 0 

41 

82% 

6 P6 
6 

30% 

4 

16% 
0 0 0 

46 

92% 

7 P7 
7 

35% 

3 

12% 
0 0 0 

47 

94% 

8 P8 
6 

30% 

4 

16% 
0 0 0 

46 

92% 

9 P9 
4 

20% 

4 

16% 

2 

6% 
0 0 

42 

84% 

10 P10 
6 

30% 

4 

16% 
0 0 0 

46 

92% 

11 P11 
2 

10% 

7 

28% 

1 

3% 
0 0 

41 

82% 

12 P12 
3 

15% 

7 

28% 
0 0 0 

43 

86% 

13 P13 
4 

20% 

6 

24% 
0 0 0 

44 

88% 

14 P14 
1 

5% 

5 

20% 

4 

12% 
0 0 

37 

74% 

15 P15 
1 

5% 

9 

36% 
0 0 0 

41 

82% 

16 P16 
2 

10% 

7 

28% 

1 

3% 
0 0 

41 

82% 

17 P17 
4 

20% 

5 

20% 

1 

3% 
0 0 

43 

86% 

18 P18 
1 

5% 

9 

36% 
0 0 0 

41 

82% 

19 P19 
4 

20% 

6 

24% 
0 0 0 

44 

88% 

20 P2 
7 

35% 

3 

12% 
0 0 0 

47 

94% 

TOTAL 
1.726 

86,3% 
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Lampiran 14:Hasil Respon Siswa Berdasarkan Indikator 

 

No Pernyataan SS S KS TS STS 

1 P1 13 7 0 0 0 

2 P2 9 10 1 0 0 

3 P3 3 15 2 0 0 

4 P4 5 13 2 0 0 

5 P5 11 8 1 0 0 

6 P6 5 13 2 0 0 

7 P7 6 13 1 0 0 

8 P8 10 9 1 0 0 

9 P9 9 9 2 0 0 

10 P10 7 10 3 0 0 
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122 
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Lampiran 15 : Perhitungan Uji Validasi Menggunakan SPSS 22.0 for windows 
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Lampiran 16 : Perhitungan Reliabilitas Menggunakan SPSS 22.0 for windows 
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Lampiran 17 : Hasil Pretest dan Posttest  

Nama Pretest Posttest 

Andrian Dava. 

Ahmad Haikal R. 

Aprilia Dwi Cahyanti 

Ervina Wati 

Halimatuzzahrah 

Maria Ulpah 

Muhammad Hamka 

Muhammad Irfansyah 

Nadia Rahmawati 

Nur Syarifah 

Noraida Aprianti A. 

Noval Zaini F. 

Putri Hidayah 

Rayhan Triwiyasa P. 

Rezky Aulia 

Savera Ramadhani 

Siva Nuria 

Surya Fadilah 

Yulia Rahmah 

Dhiya Shafa Abiyyu P. 

62,5 

50 

62,5 

75 

37,5 

37,5 

25 

75 

62,5 

50 

75 

62,5 

50 

50 

37,5 

50 

25 

62,5 

50 

62,5 

75 

62,5 

100 

100 

87,5 

75 

50 

87,5 

100 

75 

75 

87,5 

75 

87,5 

62,5 

87,5 

62,5 

75 

75 

87,5 
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Lampiran 18 :Deskripsi Hasil Pretest dan posttes menggunakan SPSS 22.0 for 

windows. 

1. Memasukkan data ke SPSS, buka lembar kerja baru klik File > New 

>Data, terlihat tampilan Variabel View  kemudian masukkani Name dan 

Property Variabel. 

 

2. Setelah nama Variabel didefinisikan, langkah selanjutnya adalah mengisi 

data hasil pretest dan posttest, lalu kembalilah pada tampilan Data View. 
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3. Pilih Analyze >Descriptive Statstic > Explore, lalu pindahkan nilai pretest 

ke kotak Dependent List, Kemudian pada Display klik Ok. 

 

 

 

 

4. Hasil Output dan hasil analisisnya 

a. Output Hasil Pretest 
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Case Processing Summary 

 

Cases 

Valid Missing Total 

N Percent N Percent N Percent 

PRETEST 20 100.0% 0 0.0% 20 100.0% 
 

 

Descriptives 

 

 Statistic Std. Error 

PRE

TEST 

Mean 53.13 3.378 

95% Confidence Interval for 

Mean 

Lower Bound 46.05  

Upper Bound 60.20  

5% Trimmed Mean 53.47  

Median 50.00  

Variance 228.207  

Std. Deviation 15.107  

Minimum 25  

Maximum 75  

Range 50  

Interquartile Range 22  

Skewness -.335 .512 

Kurtosis -.557 .992 

 

 

Ringkasan statistika deskritif hasil pretest siswa: 

1) Mean hasil pretest peserta didik sebesar 53,13 dengan range sebesar50. 

2) Median sebesar 50,00. 

3) Variance sebesar 228,207 

4) Standar deviasi sebesar 15,107 

5) Nilai minimum sebesar 25, maksimumnya sebesar 75.  
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b. Output Hasil Posttest 

Case Processing Summary 

 

Cases 

Valid Missing Total 

N Percent N Percent N Percent 

POSTEST 20 100.0% 0 0.0% 20 100.0% 

 

Descriptives 

 Statistic Std. Error 

POSTEST Mean 79.38 3.045 

95% Confidence 

Interval for Mean 

Lower Bound 73.00  

Upper Bound 85.75  

5% Trimmed Mean 79.86  

Median 75.00  

Variance 185.444  

Std. Deviation 13.618  

Minimum 50  

Maximum 100  

Range 50  

Interquartile Range 13  

Skewness .250 .512 

Kurtosis -.263 .992 

Ringkasan statistika deskritif hasil posttest siswa: 

1) Mean hasil postest peserta didik sebesar 79,38 dengan range sebesar 50. 

2) Median sebesar 75,00. 

3) Variance sebesar 185,444 

4) Standar deviasi sebesar 13,618 

5) Nilai minimum sebesar 50, maksimumnya sebesar 100.  
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Lampiran 19 : Uji Normalitas Hasil Pretest dan Posttest  

1. Masuk program SPSS , klik Variabel View pada SPSS data editor, kemudian 

pada kolom Name baris pertama isi dengan pretest/posttest, pada Decimals 

pilih 0. 

 

 

 

2. Masukkan nila ke Data View 
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3. Klik Analyze > Nonparametic Test > Legacy Dialogs > 1- Sample k-s. 

 

4. Masukkan Pretest/Posttest ke kotak Test Variabel List 

 

5. Klik exact Test pilih Exact, kemudian klik Continue 
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6. Klik Ok > Hasil Output 

 

Hasill Output dan analisis uji normalitas hasil pretest dan posttest 

One-Sample Kolmogorov-Smirnov Test 

 PRETEST POSTTEST 

N 20 20 

Normal Parametersa,b Mean 53,13 79,38 

Std. Deviation 15.107 13.618 

Most Extreme Differences Absolute .183 .176 

Positive .132 .176 

Negative -.183 -.175 

Test Statistic .183 .176 

Asymp. Sig. (2-tailed) .079c .105c 
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a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 

 

Lampiran 20 :Uji Homogenitas 
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Lampiran 21: Uji Paired Sampel T Test Menggunakan SPSS 22.0 for windows 

1. Buka aplikasi SPSS, klik variabel view, lalu isi kolom name baris pertama 

dengan pretest dan baris kedua dengan posttest, lalu pada bagian Decimals 

gant angkanya menjadi 0, bagian label pretest dan posttest. Measure pilih 

scale. 
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2. Lalu klik data view dan input data pretest dan posttest peserta didik. 

 

 

3. Klik Analyze, lalu pilih compore means, kemudian klik paired sample t-test 
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4. Masukkan data pretest pada variable 1 dan posttest pada variabel 2. 

 

 

 

 

5. Klik option lalu pada confidence interval percentage masukkan angka 95, 

kemudian klik continue 
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6. Klik ok 

  

Hasil output analisis keputusan uji Paired Sample T-Test 

Paired Samples Test 

 

Paired Differences 

t df 

Sig. 

(2-

tailed) Mean 

Std. 

Deviatio

n 

Std. 

Error 

Mean 

95% Confidence 

Interval of the 

Difference 

Lower Upper 

Pair 

1 

PRETEST - 

POSTTEST 
-26.250 12.099 2.705 -31.912 -20.588 -9.703 19 .000 

 

a.  Lihat nilai .Sig.(2-tailed). Jika Sig. > 0,05 , Maka H0 diterima, Ha ditolak. 

b. Lihat nilai .Sig.(2-tailed). Jika Sig. < 0,05 , Maka H0 ditolak, Ha diterima. 
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Lampiran 22 : Modul Ajar 

 

 

 



154 

 

 
 
 

 

 

 

 



155 

 

 
 
 

 

 

 



156 

 

 
 
 

 

 

 



157 

 

 
 
 

 

 



158 

 

 
 
 

 

 

 

 

 

 



159 

 

 
 
 

 

 

 

 

 

 

 



160 

 

 
 
 

 

 

 

 



161 

 

 
 
 

 

 

 



162 

 

 
 
 

 

 

 



163 

 

 
 
 

 

 

 

 

 



164 

 

 
 
 

 

 

 

 

 



165 

 

 
 
 

 

 

 

 



166 

 

 
 
 

 

 

 

 



167 

 

 
 
 

 

 



168 

 

 
 
 

 

 

 

 

 

 



169 

 

 
 
 

 

 

 

 

 

 

 



170 

 

 
 
 

 

 

 

 

 

 



171 

 

 
 
 

Lampiran 23: Buku Konsultasi 
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Lampiran 24: Media Animasi 

Link video : https://youtu.be/kwUaASswA6w?si=skBpFLXuYeCRgJXi  

  

  

 

 

 

https://youtu.be/kwUaASswA6w?si=skBpFLXuYeCRgJXi
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Lampiran 25: Dokumentasi 

Validasi di SMA Negeri 1 Gambut 

Pertemuan Pertama 

  

Pertemuan kedua 

  

Pertemuan Ketiga 
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